
介绍
感谢您选择 SCIEX 作为您的系统供应商。我们很高兴为您提供 SCIEX OS 2.1.6 软件，它可支
持下列系统：

• ZenoTOFTM 7600 系统

• SCIEX X500R QTOF 系统

• SCIEX X500B QTOF 系统

• SCIEX Triple QuadTM 7500 LC-MS/MS System – QTRAP® Ready

• Echo® MS 系统，它包括 SCIEX Triple QuadTM 6500+ 系统和 Echo® MS 模块

SCIEX OS此外，2.1.6 还允许用户处理从三重四极杆系统、QTRAP® 以及运行 1.6.2 或更高版
本的 TripleTOF® 软件或者 1.7.1 或更高版本的 Analyst® 软件的 Analyst® TF 系统采集的
数据。

本文档介绍了软件的功能。我们建议用户保留这些版本发布说明，以在熟悉软件的过程中用作
参考。

版本 2.1.6 的新增功能
本节介绍 SCIEX OS 2.1.6 的改进和修正。要查看 SCIEX OS 之前版本的改进和修正，请参阅
该版本软件随附的版本发布说明。

2.1.6 版的新功能和改进

• SCIEX OS 2.1.6 支持包含 SCIEX Triple QuadTM 6500+ 质谱仪的 Echo® MS 系统。

注释： 如果此版本的 SCIEX OS 将与 Echo® MS 系统结合使用，则必须更新 Echo® MS 系
统的固件。请联系 SCIEX 现场服务人员 (FSE)。

• 软件更新功能可供用户确定是否有更高版本的软件可用。

注释： 如果软件更新功能无法与 SCIEX 通信，则联系本地网络管理员，以确保端口 443
打开，且计算机上安装了 Transport Layer Security (TLS) 1.2。

• SCIEX OS 可以安装在英语、法语、德语或西班牙语的 Windows 操作系统上。需要英语语言
支持，但是可将 Regional Settings 设置为英语、法语或德语。(BLT-2325)

• Batch 工作区中的 Barcode 字段的字符限制提高到 250 个字符。(BLT-2212)
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• 在选择了 Analyst 选项的情况下使用 Export and save results table 命令从 SCIEX OS
导出的 Results Table 与从 Analyst® 软件导出的 Results Table 现在格式相同。
(BLT-2365)

• （ExionLCTM 和 Shimadzu LC 系统）增强 Direct Control 功能，可供用户控制 LC 模块的
参数。(ONYX-8128)

• （SCIEX 7500 系统）指定的 Curtain Gas 值小于推荐值时提醒用户进行确认。(ONYX-10763)

• 在计算列中，IF 条件现在可以测试这些列中的置信度红绿灯 (MQ-8469)：

• Mass Confidence

• Fragment Mass Confidence

• RT Confidence

• Isotope Confidence

• Library Confidence

• Formula Confidence

• Combined Rules

Echo® MS 系统的新功能

• 用户可以选择使用所提交批次中指定的采样序列或者优化（行蛇形）序列。以前，无论在批
次中怎样设置，都仅使用优化序列。要启用此选项，在 Direct device control 对话框中
选择 Tools > Settings，然后清除 Optimize ejection sequence of batch samples 复选
框。(OPP-211)

• 流动相泵的流速现在是移动平均值。(OPP-327)

• 直接输注支持的最短持续时间现在为 5 秒。(OPP-307)

• 模拟模式已得到改善。(OPP-224)

• Echo® MS 系统的闲置时间现在可以通过在 Direct device control 对话框中选择 Tools >
Settings 进行配置。(OPP-330)

• 流动相灌注功能现在可从 Direct device control 对话框中调用。使用此功能向传输管路
中填充流动相。要访问此功能，请选择 Tools > Maintenance。(OPP-347)

• AE 方法信息现在包含在 wiff2 文件内的样本信息中。(OPP-353)

• 新 Run Log Level 选项可创建详细的日志文件，属于服务包的一部分。要选择此选项，选
择 Tools > Maintenance，然后在 Run Log Level 字段中选择 Diagnostics。(OPP-399)

• 采集方法的运行时间已优化。对于配置为每个孔间隔 1 秒的 AE 方法，运行时间大约缩短
了 17 秒。(OPP-349)

• 如果全谱数据或标记孔中的错误导致采集结果不可行，则采集停止。(OPP-298, OPP-366)
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已在 2.1.6 版中解决的问题

Echo® MS 系统

• Echo® MS 模块在 Simulation 模式中进入 Fault 状态。(ONYX-6697)

• 在 Event Log 工作区中，包含 Echo® MS 模块事件的页面显示为 LC，而非 AE。(ONYX-7075)

• 当泵停止时，耦合液体泵显示最后的泵速度而不是指示零。(OPP-276)

• 有些关键故障和警告错误在重置之后未保留。(OPP-269)

• 系统在清除了采集初始化期间触发的故障和错误（例如下面的情况）后未重新初始化：

• 如果采集在 OPI 移动期间停止。(OPP-279)

• 如果队列停止。(OPP-280)

• 如果紧急关闭开关在 OPI 移动期间激活。(OPP-283)

• 如果在孔板加载过程中发生液体渗漏或 TFA 溢出。(OPP-284)

• 如果在孔板加载或分类过程中发生 OPI 或流动相渗漏。(OPP-285)

• 如果质谱仪处于 Idle 状态，则无法清洗 Echo® MS 模块。(OPP-290)

• Batch 工作区中的 Plate Layout 未更新，与导入的 csv 文件中的孔板类型不匹配。
(OPP-295)。

• 如果 Echo® MS 系统的积分服务正在运行，则 NECO 诊断会显示错误。(OPP-296)

• 流动相泵间歇性地未启动。(OPP-378)

• 当前孔板间歇性地需要多次尝试才能卸载，或者 Unload 按钮未启用。(OPP-379)

• 如果质谱仪的气体 1 供应未处在正确压力 (90 psi)，则采集未启动。系统仍处于 Pre-Run
状态。(OPP-319)

• 当 Echo® MS 系统在模拟模式中运行时，采集完成后进入了 Fault 状态。(OPP-301)

其他设备

• (Shimadzu LC) 在处理完多份样本后，压力曲线显示压力直接下降为零，然后再返回至其原
始压力。(ACQ-2043)

• （ExionLCTM 系统）软件无法按 0.1 µL 的增量对 0.1 µL 到 10 µL 的进样体积执行进样。
(BLT-2189)

• 无法同时配置多个 LC 设备。(BLT-2206)

• (Shimadzu LC) 当 LC 系统停用时，LC 系统关机，并关闭自动进样器中的冷却器以及板变
换装置。(BLT-2300)

• （SCIEX 7500 系统）与注射泵的通信丢失。(BLT-2563)

• 当 Agilent DAD 连接到 Shimadzu LC 堆栈时，在 DAD 迹线的数据采集开始时存在 0.2 分
钟的延迟。(ONYX-8120)
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• 如果设备配置中包含配置为以通道模式采集数据的检测器，且采集数据包含重复的波长，则
在 Data Acquisition 面板和 Explorer 工作区中显示的波长数据不正确。(ONYX-8382)

• 如果配置有触点闭合的设备使用预定的离子化功能，离子化过程可能在通过触点闭合控制的
设备开始进样前开始。(ONYX-8626)

Batch 工作区

• （SCIEX 7500 系统）从 Watson LIMS 导出的文本文件无法导入到 Batch 工作区。(BLT-2460)

• 如果批次中为 Results File 指定的文件路径太长，自动处理会失败。(ONYX-8356)

Analytics 工作区

• 仅提供两个小数位来定义保留时间窗口。(BLT-1579)

• 客户无法打开 Analytics 工作区，因为与 LibraryViewTM 软件数据库存在通信问题
(BLT-2110)

• Calibration Curve 窗格中显示了一个红叉。(BLT-2175)

• 工作区的更新存在延迟。例如，在 Results Table 中选择了多种成分时 Calibration Curve
窗格更新很慢，而在清除或选中了 Reportable 复选框时 Results Table 更新很慢。
(BLT-2336)

• 导出谱库需要管理员访问权限。(BLT-2439)

• 当用户尝试向谱库中添加谱图时，如果谱库中已存在大量名称相似的化合物，则提示用户创
建新化合物。但是，该化合物无法创建，因为谱库中已存在同名的化合物。(BLT-2452)

• 当输入列更新时，根据组合规则计算出的列未自动更新。(BLT-2533)

• 当 Peak Review 窗格取消停靠并激活后，F4 快捷键未能添加或删除峰积分。(BLT-2551)

• 处理包含当前正在采集的样本的 Results Table 期间发生了延迟。(BLT-2560)

• 导入表显示设置 (cset) 文件时，Component Name 列移到表的右侧附近。(BLT-2564)

• 在复杂 IF 语句中执行文本（非数值）比较时，结果可能不一致。(MQ-8268)

• 软件未检查公式中的列名称或值的拼写错误。(MQ-8412)

• 在 IF 语句中未识别样本类型 Quality Control 和 Double Blank。(MQ-8549)

• 如果公式中的文本字符串包括分号 (;)，则无法正确地处理公式。(MQ-8670)

• 如果打开了多个 Results Table，并且对 Results Table 进行了三个或更多更改，则可能
不会应用对 Results Table 的更改。(MQ-8696)

SCIEX OS 补丁程序

软件包括未包含在这些补丁程序中的修正：

• 针对 Agilent 采集问题的 SCIEX OS 2.0 补丁程序：使用 Agilent 设备配置进行的采集可
能间歇性地失败，并出现错误“Sample acquisition was stopped because of a system
error”。(BLT-2160)

RUO-IDV-03-1821-ZH-S2021 年 6 月4 / 35

SCIEX OS 2.1.6 版本发布说明



• 针对 Agilent 定制孔板的 SCIEX OS 2.0.1 补丁程序。软件不支持为可支持的 Agilent 多
样品进样器定义的定制孔板：G5668A 和 G7167(A,B)。(BLT-3422)

• 针对 Shimadzu 孔板布局的 SCIEX OS 2.0.1 补丁程序：

• 不支持 Reversed Deep Well 96 孔板布局用于 Shimadzu LC30-AC 自动进样器。这种布
局与 96 Deep Well Plate 相似，但是进样瓶编号从左下部开始，每行从左到右进行编
号。(BLT-2446)

• Plate Layout 对话框不适用于 Shimadzu SIL-30ACMP 自动进样器。(BLT-2496)

使用注意事项和已知问题

使用注意事项

• 执行 Windows 更新时，用户应当仅安装所需的更新。更新应安排在系统不采集数据时。用
户不应安装可选更新，因为它们可能会影响软件功能。

注释： SCIEX OS 不支持 Windows 10 HotFix 2。(BLT-2320)

• 当一个批次开始时，SCIEX OS 会停止安装 Windows 更新、Windows Defender 病毒扫描
(Windows 10) 和 Symantec Endpoint 病毒扫描 (Windows 7)。计划更新和病毒扫描在未发
生数据采集时进行。

• 如欲避免性能问题或数据损坏，用户不应在样本采集期间执行任何计算机维护步骤，如整理
碎片或清理磁盘。

• （Echo® MS 系统）创建 MS 方法时，Spray Voltage 默认为 4500 V。

注释： 我们建议使用不超过 5000 V 的值，以最大限度延长开放端口接口 (OPI) 电极装
置的使用寿命。

• （Echo® MS 系统）由于峰较窄，我们建议尽可能减少离子对的数量。建议使用四到六个离
子对。

• （Echo® MS 系统）用户不得在多个批次中使用相同的数据或结果文件名称。在每个新批次
中始终使用新数据和结果文件。

• （Echo® MS 系统）Batch 工作区的 Injection Volume 列中输入的值不能替代 AE 方法中
指定的喷射量。

• 如果 ClearCore2 服务在网络采集期间中断，那么中断时正在采集的样本的部分样本数据将
不会写入数据文件。如果该服务在本地采集期间中断，那么部分样本数据将写入数据文件，
但是会被标记为损坏。如果 ClearCore2 服务中断，那么任何自动触发的处理和决策规则处
理也会失败。
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• 在获取网络资源时，用户可通过下列方法实时查看 Explorer 工作区中的数据：

• 打开 SCIEX OS 窗口底部的 SCIEX OS 面板。

• 在 Queue 工作区内，双击打开正在获取的样本。

(DS-1873)

注释： 如果样本在 Explorer 工作区内被打开，那么样本被移动至网络资源后会显示一条
"File not found message" 消息。

• 在 SCIEX OS 2.1.6 中创建的数据文件不能附加到 SCIEX OS 1.3.1 或先前版本中采集的数
据文件。(DS-1931)

• 为 Batch 工作区中的样本指定新的结果文件时，用户必须同时指定处理方法。如果没有指
定处理方法，则 Queue 工作区中的 Processing Method 列将包含 *Embedded Method*，且
自动处理失败。(ONYX-4864)

• MultiQuantTM 软件文件（qmethod、qsession 和 cset）不能打开或用于 SCIEX OS 的
Analytics 工作区。然而，已导出到文本文件的 MultiQuantTM 软件方法可以导入 Analytics
工作区中。

• 软件不使用选定的回归参数（面积或高度）计算成分离子率。软件将使用 Results Table
中针对第一个成分定义的回归参数计算 Results Table 中所有成分的离子率。(MQ-5546)

• 对于非目标工作流， Results Table 应限制在 150,000 行以内。当 Results Table 超出
此规模时，SCIEX OS 性能显著下降。

• 如果使用 AutoPeak 积分算法，则用户必须在特定 Results Table 内的成分背景下考虑所
有计算参数。软件会为每个成分创建 AutoPeak 模型，且此模型将用于该成分的所有样本。
AutoPeak Asymmetry 计算参数显示了特定偏离与该成分 AutoPeak 模型的偏离之比。
(BLT-2030)

• 在将数据传输到 Watson LIMS 时，用户必须等到传输成功完成，然后才能单击 SCIEX OS
中的 Confirm。如果用户在传输完成之前单击 Confirm，则传输状态显示为 Failed。

• 虽然当前审核图模板已应用至工作站，但 Apply to Workstation 按钮也还是处于活动状
态。如要确定工作站当前使用哪个审核图模板，可打开 Audit Trail 工作区。(ONYX-3400)

• 转换方法时，请确保使用 SCIEX OS 安装包中包含的 SCIEX OS 至 Analyst® 版软件方法转
换器。
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一般问题

注释问题

如果计算机上未安装 Microsoft XPS Viewer，则会
出现此问题。该查看器包含在 SCIEX OS 安装包中。
要安装该查看器，请遵循以下步骤：
1. 以管理员身份运行 Command Prompt：

a. 在 Windows 工具栏的 Type here to search
字段中，键入 cmd。

b. 右键单击 Command Prompt，然后单击 Run
as administrator。

2. 在 Administrator: Command Prompt 窗口中，
键入以下命令，然后按 Enter：
dism /online /norestart /add-package
/packagepath:"C:\Program Files\SCIEX\SCIEX
OS\Microsoft-Windows-Xps-Xps-Viewer-Opt-
Package~31bf3856ad364e35~amd64~~.cab"

注释： 在一行中键入完整命令。

安装 XPS Viewer 时会显示一个进度条。

3. 安装完成后，关闭 Command Prompt 窗口。

用户无法打开在 MS Tune 工作区中、在
调谐期间或在 MS Method 工作区中使用
Guided MRM 创建的报告 (xps) 文件。
Windows 报告无法打开这种类型的文件。

为了避免此问题，使用 SCIEX OS 中的 Analytics
工作区处理数据。

（SCIEX 7500 系统）文件路径过长的数
据无法使用 Analyst® 1.7.2 软件处理。
此外，此类数据文件的文件信息无法完整
地显示在 Analyst® 1.7.2 软件中。
(BLT-2246)

帮助文件被阻挡。为了解决此问题，请执行以下步
骤：

1. 浏览到该帮助文件，用右键单击，然后单击
Properties。

2. 在 Properties 对话框中，选择 Unblock。

3. 单击 OK。

注释： 如果 Properties 对话框不包含此复选框，
则不会阻挡帮助文件。

帮助的内容窗格为空白。(BLT-2497)
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注释问题

为了避免出现问题，请确保使用较短的文件路径。（SCIEX 7500 系统）文件路径的长度超
过 128 个字符的数据无法在 Analyst®

软件中处理。此类数据文件的文件信息中
的有些部分也未显示。(ONYX-9408)

无法再处理 wiff 数据。在 Explorer 工作区中和 Analytics 工
作区的 Peak Review 面板中再处理 wiff
数据期间发生错误。(ONYX-9450)

设备问题

注释问题

如果柱温箱的 WAIT TIME 被手动设置为 0，则确保
提交任何样本前平衡系统并在柱温箱达到设定温度
后等待 10-15 分钟。或者，将 WAIT TIME 设置为
1 - 10 的任何整数，然后在 LC 方法中选择 Wait
for temperature equilibration before run。如
果选中此选项，则在柱温箱达到设定温度后，软件
将会在等待 WAIT TIME 所设定的时间量后开始注
射。

（ExionLCTM 系统和 Shimadzu LC）进样
在色谱柱到达设定温度之前开始。

目前不支持高通量设置。(Agilent LC) 自动进样器不支持高通量
设置。(ACQ-529)

如果设备某个模块在样本提交前关闭，则 LC 系统
转到待机状态，即使状态应为 Fault 状态。如果用
户试图再次向队列提交批次，则第一个样本提交但
立即失败，因为 LC 系统转到 Fault 状态，且样本
被损坏。如果出现这种问题，请重启计算机，并再
次打开软件。

(Shimadzu LC) 当设备在恢复时，显示错
误的设备状态。(ACQ-1410)

当 LC 为 Fault 状态时，如果用户打开 Direct
Control 设备，然后单击 Clear Error，则设备会
恢复，但软件中的状态仍显示故障。要清除此错误，
单击状态面板中的 Standby。

(Shimadzu LC) 当错误通过 Direct
Control 恢复时设备红绿灯未从故障中恢
复。(ACQ-1420)

为确保系统正确运行，请关闭设备或打开与激活的
设备列表匹配的设备。

(Agilent LC) 如果已打开和连接的设备
与激活设备列表中的设备不匹配，LC 方
法未正确运行。(ACQ-1716)

此批次预计的持续时间可能比预期长。如欲避免出
现任何问题，须使用低于 12.5 Hz 的采样率。

(Shimadzu LC) 在以高于 12.5 Hz 的采
样率使用 Shimadzu PDA 运行长批次时，
会观察到性能问题。(ACQ-2037)

当极性在 LC 方法 UV 检测器部分被设置为负极性
时，就会出现这种情况。如欲避免出现任何问题，
须在极性字段使用正极性设置。

(Shimadzu LC) 在采集两个 UV 信号通道
时，采集了倒置 UV 数据。(ACQ-2042)
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注释问题

如果出现这种问题，单击 Standby 以便将 LC 返回
Ready 状态。

(Agilent LC) Agilent LC 显示 Fault
状态，即使模块已从故障中恢复并进入
Ready 状态。(ACQ-2144)

如欲避免出现该问题，请确保 LC 方法时长的 Stop
Time 字段中的值是 LC 方法必须运行的最长时间。

当 LC 方法中的 LC 泵或柱温箱温度表的
梯度表时长长于 MS 方法的时长，LC 设
备将在 MS 方法时长过期时停止运行。
(ACQ-2167/2088)

如欲避免出现任何问题，请确保 PDA 设备使用正确
的参数。

（ExionLCTM AC/ExionLCTM AD 系统和
Shimadzu LC）PDA 默认参数不同，取决
于如何访问 LC 方法。(ACQ-2176)

这是 Agilent LC 的问题。如欲避免出现该问题，
请手动输入流率，并使用逗号作为小数分隔符。

(Agilent LC) 当 LC 梯度网格中的流率
被复制时，逗号被视为小数分隔符而被忽
略。(ACQ-2191)

如果出现这种问题，请清除设备故障，然后停用和
重新激活 Agilent 设备。

(Agilent LC) 如果设备在设备激活期间
为 Fault 状态，则 Fault 状态未被正确
反映。(ACQ-2195)

某些情况下，在手动添加设备时，Test device 功
能失效。为避免该问题，请使用 Autoconfig 添加
设备。

某些情况下，设备不能手动添加。
(ACQ-3014)

添加第四种冲洗溶剂，并减少每种冲洗液的体积，
以缩短冲洗时间。

当选择一种、两种或三种冲洗溶剂时，冲
洗不会发生。(BLT-1212)

不适用(Shimadzu LC-40) 在系统进入待机状态
后，或者停用后，温度恢复到在上一个平
衡程序或 LC 方法中设置的温度。
(BLT-2300)

如果发生此问题，则单击 Direct Control 中的
Start 将 CDS 状态从 Fault 更改为 Running，以
清除 CDS 的 Fault 状态。

在设备（如 CDS）发生故障时，系统未激
活右侧状态窗格上的 Standby 按钮，导
致用户无法清除错误。(MSCS-1314)

在质谱仪处于 Ready 或 Idle 状态时再次激活设
备。

如果质谱仪未激活或在 Fault 状态被激
活，则不显示质谱仪质量模式。
(MSCS-2065)

安装 SCIEX OS 1.7 后，停止 ClearCore2 服务，
然后从 SCIEX OS 2.0 安装包的 Install 文件夹安
装 C++ redistributables (vc_redis*.exe)。

从 SCIEX OS 2.0 降级到 SCIEX OS 1.7
后，用户无法在 Devices 工作区中配置
SCIEX X500 QTOF 系统。(MSCS-2286)

如果 Windows 区域设置被设置为 English (United
States) 以外的格式，则会出现此问题。为避免此
错误，请按照《软件安装指南》中的说明配置
Windows。

LC 系统的 Device Details 对话框缺失
信息。(ON-2069)
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注释问题

如果选中下面的其中一个或两个选项，将会在样本
瓶缺失时发生此问题：
• Queue Settings 页面上的 If a sample is
missing, then proceed to the next sample。

• Direct Control 对话框上的 Ignore missing
vessel。

如果未选中上述任何选项，则系统将进入 Fault 状
态且样本会失败。

为避免发生此错误，请清除上述选项，然后确保所
有的样本瓶都在。

(Agilent LC) 如果样本瓶缺失，则系统
将无法确认缺失的样本瓶以及注入气体。
(ONYX-4849)

不支持 Apex 和 All in Peak 质谱模式。使用另一
种模式。

(Agilent LC) 当质谱模式被设置为 Apex
或 All in Peak 时，Agilent G7121B
1260 Infinity II FLD Spectra 模块的
实时 DAD 数据未记录。(ONYX-4998)

如果信号 A 激励被设置为零阶，则将 PMT 增益设
置为 6 或以下。

(Agilent LC) 当信号 A 激励被设置为零
阶且光电倍增管 (PMT) 增益被设置为大
于 6 时，如果正在使用 Agilent G7121B
1260 Infinity II FLD Spectra 模块，
则系统仍处于 Loading 或
Equilibrating 状态。(ONYX-4999)

不适用当用户在 LC Method 工作区按下 F1
时，SCIEX OS 的帮助系统和 LC 系统的
帮助都会打开。(ONYX-7149)

当用户在未登出采集计算机的情况下断开并重新连
接远程桌面会话时，会发生此问题。如欲避免这个
问题，请使用以下方法之一：
• 登出采集计算机，然后再次登录。

• 使用远程桌面应用的全屏模式。

• 纠正采集计算机的分辨率。

• 直接在采集计算机上查看详细的状态。

当使用远程桌面应用访问采集计算机时，
可能会发生以下问题：

• 在 LC Method 工作区中，某些参数不
可见。

• 在 LC 系统的 Detailed Status 对话
框中，某些 LC 参数不可见。

(ONYX-7153/ONYX-8048/ONYX-8185)

不适用(Shimadzu LC) Nexera Mikros LC 泵在
达到最大压力限值时不会进入故障状态。
(ONYX-7794)

等待下一个样本开始运行，然后再次打开 Detailed
Status 对话框查看 Time。

在分流阀的 Detailed Status 对话框
中，当系统处于平衡和加载状态时 Time
值不正确。(ONYX-7831)

LC 系统的性能不会受到影响，但是会在数据文件、
日志和审核记录中错误地识别泵。

(Shimadzu LC) Nexera Mikros LC 泵在
设备配置中被错误识别为 LC-20AB 泵。
(ONYX-8030)
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保存批次并重新打开，可在 Plate Layout 对话框
中正确显示孔板名称。

(Shimadzu LC-40) 在 Plate Layout 对
话框中，如果用户要配置含多个孔板的支
架类型，则当用户完成孔板配置并选择下
一个孔板时，已配置孔板的名称会更改为
<Unassigned>。(ONYX-8441)

先手动启动注射泵，然后再开始调谐程序。在调谐期间，SCIEX OS 未自动启动和停
止外部注射泵。(ONYX-8459)

不适用（ZenoTOFTM 7600 系统）Detailed
Status 窗格中的 OptiFlow® Turbo V 离
子源名称不正确。(ONYX-10450)

• 当在 SCIEX OS 中配置了 Echo® MS 系统时，切
勿使用决策规则。

• 当 Echo® MS 系统处于活动状态时，切勿激活 LC
系统。

• 当 Echo® MS 系统处于活动状态时，切勿调谐 MS
Tune 工作区。

SCIEX 6500+ 系统的调谐使用 IonDriveTM Turbo V
离子源和相关探针执行。

（Echo® MS 系统）适用下列限制：
• 决策规则无法正确地用于 Echo® MS
系统。

• LC 系统不能用在包含 Echo® MS 系统
的配置中。

• 如果配置了 Echo® MS 系统，则不能
使用 MS Tune 工作区。

(ONYX-10636)

不适用(Waters LC) Explorer 工作区中显示的
Sample Information 中缺失 LC 设备属
性和方法信息。(ONYX-11604)

不需要详细的运行日志文件时，将 Run Log Level
设置为 Normal。

（Echo® MS 系统）将 Run Log Level 设
置为 Diagnostic 会影响系统性能。
(OPP-399)

这只是用户界面问题。系统功能不受影响。（Echo® MS 系统）在泵停止之后，显示
的流动相流速间歇性地不为零。
(OPP-412)

如果清除了 Optimize ejection sequence of
batch samples，建议不要采用列蛇形序列进行样本
发射。

（Echo® MS 系统）使用列蛇形采样序列
时，可能会出现问题：

• 液滴捕获的丢失率可能较高，导致重
现性较差。

• 沿着 Y 轴长时间前后移动产生的附加
载荷可能会导致运动机构一直承受压
力。

(OPP-211)
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采集问题

注释问题

要删除行，请选中它们，然后点击鼠标右键并单击
Delete Rows。

（Echo® MS 系统）当 Plate Layout 对
话框中的条目被删除时，行不会从 Batch
工作区中删除，且某些字段会保留。

单击 Windows 任务栏上的 SCIEX OS 图标以恢复
SCIEX OS 窗口。

（Echo® MS 系统）当用户关闭 Plate
Layout 对话框时，SCIEX OS 会最小化到
Windows 任务栏。
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注释问题

为避免任何问题，请使用 XPS 选项而非 PDFactory
选项进行打印。

在 Batch 和 Queue 工作区中，使用
PDFactory 选项的打印输出存在以下问
题：
• 在名称为数字的情况下，用 PDFactory
生成的报告不包括任何数值，如方法
名称、样本名称、样本标识号、条形
码等。(ONYX-2236)

• 以横向模式使用 XPS 和 PDFactory
打印报告能获得预期效果，但如果在
纵向模式使用 PDFactory，第一页的
最后两列就会被忽略，该批次的打印
时间也会被截断。(ACQ-1275)

如果发生此问题，则重启软件。在 Batch 工作区内，如果复制了不同项
目的方法，则可用的 MS 和 LC 方法列表
不完整。(ACQ-2127)

要避免此问题，请勿使用 Tab 键在单元格之间移
动。删除单元格的全部内容，然后再次键入 Data
File。

如果 Data File 位于单元格中央，用户
按下 Shift + Tab 以移动至下一单元格，
则会显示错误，且无法提交批次。
(ACQ-2135)

在手动采集期间，使用 SWATH®和 MRM HR 方法，离
子源气体和温度参数可在用户界面中编辑。但用户
更改未更新到质谱仪中，且记录在样本信息中的更
改未更新至该样本。

（SCIEX X500 QTOF 系统）质谱仪的离子
源参数未更新。(ACQ-2177)

如欲避免该问题和清除错误，须使用 Direct
Control 功能启动注射泵。

当选择 Standby 时，Harvard 注射泵转
向 Fault 状态。(ACQ-2193)

如欲避免出现该问题，请勿向自动进样器时间程序
表添加加注事件。

在使用 Shimadzu LC 时，如果自动进样
器时间程序表中有加注事件，系统将无法
执行加注。(ACQ-2242)

当用户执行以下操作时，UI 中显示的列并不会全部
显示在方法的打印输出中：
1. 创建一个 MRM HR 方法。

2. 应用扫描时间表。

3. 选择显示高级参数。

4. 保存，然后打印方法。

如欲避免出现此问题，须将纸张尺寸更改为比信纸
尺寸大的尺寸。

（SCIEX X500 QTOF 和 ZenoTOFTM 7600
系统）对于 Scheduled MRMHR 方法，质量
表列不打印。(ACQ-2611)
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为避免出现这个问题，用户可以执行下列操作之一：
• 如果用户在 MS Method 工作区内完成手动采集
后提交了不含校准样本的批次，则样本间校准将
表现出预期行为。批次中的第一个样本用于生成
参考列表，用以校准后续样本。

• 如果在手动采集的过程中，用户提交了包含校准
样本的批次，样本间校准将表现出预期行为，不
会观察到任何质量精度偏移。

（SCIEX X500 QTOF 系统）在手动调谐
中，如果用户在无校准样本（即无 CDS
或 LC 自动校准）的情况下提交批次，则
手动 MS 方法采集中的离子将用做首个样
本和批次中所有后续样本的样本间 DBC
参考列表。如果用于手动采集的 MS 方法
与批次中提交的方法之间存在质量范围、
极性等任何不匹配之处，则由于批次中所
有样本的质量准确度偏移，样本间校准将
失败。(ACQ-2834)

关闭该方法，然后再次打开。当用户打开 MS 方法时，Print 按钮不可
用。(ACQ-3301)

从采集方法中导入的信息的质量准确性保留两位小
数。在处理方法中用于计算质量准确性的方程式生
成的结果保留四位小数。因此，这可能导致两种方
法生成的结果不一致。

导入采集方法和处理方法出现不一致从而
导致定性结果不可信。(BLT-284)

保存、关闭然后重新打开方法。（SCIEX X500 QTOF 系统）对于 MRM HR
方法而言，当在 MS Method 工作区中更
改方法持续时间时，保留时间不被验证。
(BLT-961)

为了实现增强的批次稳定性，请在信号模式下使用
DAD。

在质谱模式下通过 DAD 采集数据时，批
次失败。(BLT-978)

如欲避免出现此问题，须降低 DAD 采集的频率，或
者在完成采集后检查数据。

DAD 面板的实时更新可能比本方法中所选
择的响应时间慢。 (DS-853)

为避免任何问题，应使用 Explorer 工作区检查采
集后的数据。

实时 UV 数据采集期间，XWC 与 TWC 图
形的峰标记不一致。(DS-1262)

这些字段在这一版的软件中已经重新定义。请重新
自动填充。

(Agilent LC) 当打开通过 SCIEX OS 1.2
或更早版本创建的批次时，LC 信息（例
如 Rack code、Rack position 和 Plate
code）缺失。(DS-2186)

如果发生此问题，可清除 Direct Control 对话框
中的 Wash 模式选项。

（SCIEX X500 QTOF 系统）软件停止响应
后，CDS 依然保持 Wash 模式。
(MSCS-666)

当使用大气压化学电离探针时，出现用户消息显示
离子源气体 2 设置应为特定值。忽略用户消息中的
离子源气体 2 设置。

离子源气体 2 设置包含在用户消息中。
(MSCS-943)

此错误不影响采集。用户可以取消消息，采集将继
续进行。

（SCIEX X500 QTOF 系统）更改探针时，
会显示一条错误消息。(MSCS-972)
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在 IDA 全谱扫描中，若使用实施 sMRM 触发的
Scheduled MRMTM 算法，则不要使用包含列表。

（SCIEX 7500 系统）在 IDA 全谱扫描方
法中，若使用实施 sMRM 触发的
Scheduled MRMTM 算法，将不会使用
Inclusion list。(MSCS-2270)

• 在循环的 Scheduled MRMTM 算法实验中关闭 sMRM
触发。IDA 强度阈值将会应用到 MRM 全谱扫描
的候选质量。

• 将 MRM 全谱扫描更改为使用 Scheduled MRMTM

算法，并将所关注的化合物保留时间设置为 0。
IDA 强度阈值将会应用到全谱扫描的候选质量。

（SCIEX 7500 系统）当采用 MRM 全谱扫
描的 IDA 实验与另一个采用实施 sMRM
触发的 Scheduled MRMTM 算法的实验发生
循环时，在 IDA 标准的 Intensity
threshold exceeds 字段中指定的触发阈
值将不会应用到 MRM 全谱扫描的候选质
量。(MSCS-2283)

如果使用 EAD 碎裂，则累积时间必须为反应时间的
至少三倍。否则，不会采集任何数据。为了解决此
问题，可以增加累积时间。

（ZenoTOFTM 7600 系统）在 EAD 碎裂模
式中未采集数据。(MSCS-2527)

算法选择了正确的前体离子，因此采集的数据正确。（SCIEX X500 QTOF 和 ZenoTOFTM 7600
系统）在质量亏损 IDA 标准中，显示的
负质量亏损值的符号有误。(MSCS-2537)

如果用户将 Turbo VTM 离子源更换为 OptiFlow®

Turbo V 离子源，则可能会发生这种问题。停用设
备，然后再次将它们激活。

（ZenoTOFTM 7600 系统）如果安装了配有
NANO 探针的 OptiFlow® Turbo V 离子
源，并且启用了触点闭合，则自动校准不
可用。(MSCS-2543)

如欲避免出现任何问题，在运行 IDA 之前，请确保
Google 更新服务（gupdate 和 gupdatem）（如果
系统上存在此服务）以及 Windows 备份已被禁用。

IDA 采集过程中可能会有额外时间被增加
到随机循环。(ONYX-1764)

虽然用户界面未更新，但仪器所使用的参数是正确
的，且参数更改已经保存在文件信息中。

（SCIEX X500 QTOF 系统）在运行校准物
时，MS Method 工作区未更新以显示正确
信息。(ONYX-2127)

如果使用文本编辑器将以逗号 (,) 分隔的列添加到
csv 文件的行中，而逗号和列文本未添加到其他行
时，则会出现此问题。

1. 将 Mass Table 导出到 csv 文件。

2. 在 Microsoft Excel 中打开导出的文件。

3. 编辑 Mass Table。

4. 保存已更新的 csv 文件。

5. 再次导入该文件。

当在 MS 方法的 Mass Table 中导入 csv
文件时，如果导入文件的列数大于 Mass
Table 中的列数，则不会显示错误消息。
(ONYX-5216)
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要删除 Mass Table 中的内容，请使用以下方法之
一：
• 使用 Backspace 键删除文本。

• 双击单元格进入编辑模式，然后使用 Delete
键。

然后，根据需要键入新文本。

在 MS Method 工作区中，当用户为 MS
方法编辑 Mass Table 时，Delete 键不
起作用。(ONYX-5467/ONYX-7384)

将缺失的成分手动添加到批次中。从 Excel 电子表格等文件复制行并将其
粘贴到 Batch 工作区的网格时，某些成
分未添加到网格中。(ONYX-6068)

为避免此问题，不要粘贴到现有行，而是插入空行
并在其中粘贴新内容。然后删除现有行。

当用户在 Batch 工作区中粘贴行到现有
行时，内容不会被正确粘贴。(ONYX-6083)

如果 MS 方法列表为空，则找到损坏的方法并将其
删除。

当 Acquisition Methods 文件夹包含损
坏的 MS 方法时，Batch 工作区的 MS
Method 列中没有可用的 MS 方法可供选
择。(ONYX-6795)

不适用当用户使用选项 Stop after the current
tasks are completed 停止队列时，采集
完成，且处理不会开始。(ONYX-6802)

在处理第一个样本时，将会创建 Results 文件并会
将 Processing Method 列中指定的处理方法嵌入到
新的 Results 文件中。因此，为重新进样的样本指
定的嵌入方法与为第一个样本指定的处理方法相同。

在 Queue 工作区中，因决策规则处理而
重新进样的样本显示在 Processing
Method 列的 *Embedded Method* 中，而
不是与原始样本相关联的处理方法名称
中。(ONYX-6896)

峰分离在采集数据后执行。如果系统正在分离上一
次采集期间写入文件的峰，同时后续批次将数据采
集到该文件中，则会发生资源冲突。为避免发生此
问题，将每个批次的数据写入单独的数据文件中。

（Echo® MS 系统）当连续批次将数据保
存到相同数据文件时，峰分离失败，且自
动处理失败。(ONYX-6904)

在采集 IDA 数据时，请勿使用远程桌面控制采集计
算机。

如果采集计算机在采集 IDA 数据期间由
Windows 远程桌面控制，则采集性能可能
降低，导致数据点丢失。(ONYX-7491)

打印该方法之前关闭 PDF 文件，或者使用不同的文
件名保存。

当用户尝试将方法打印到当前打开的 PDF
文件时发生错误。(ONYX-7813)

当用户在负极性中为 MS3 实验设置 AF2 的默认值
时，不会保存默认值。

要在负极性中保存 AF2 的默认值，首先使用负极性
所需的 AF2 值配置正极性。然后再更改为负极性并
保存默认值。

（QTRAP® 系统）在负极性中，不能为 MS3

实验设置 AF2 的默认值。(ONYX-8041)
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注释问题

如果用户选择未在该处理方法中应用的组合标记规
则，则不会执行队列中的任何决策规则处理。

在 Decision Rule Configuration 对话
框中，选择处理方法后，Flagging Rules
字段中的列表可能会包括该处理方法所定
义的组合标记规则，但不会应用。即
Apply Rule 复选框不会被选中。
(ONYX-8352)

如果扫描时间太长，使用 DurationScheduled MRMTM

可能无效。如果用户尝试保存该方法，则会显示错
误消息且 Duration 字段会包含错误图标。如果用
户指定了有效的方法持续时间并将该持续时间改回
不正确的方法持续时间，然后保存该方法，则该方
法会成功保存。

请确保在保存该方法前确定正确的方法持续时间。

使用 Scheduled MRMTM 算法的 MS 方法可
能以无效的方法持续时间进行保存。
(ONXY-8443)

打印之前，在 Print 对话框中将文档方向从纵向改
为横向。

（SCIEX X500 QTOF 系统）在打印
Scheduled MRMHR 方法时，该报告未包含
Mass Table 中的所有列。(ONYX-8563)

使用正确的 CE 值进行采集。（SCIEX 7500 系统）在 Negative IDA
实验极性中，碰撞能量 (CE) 参数的极性
未正确显示。(ONYX-8566)

单击 OK。（SCIEX 7500 系统）如果用户没有按顺
序完成所有前序步骤，在步骤 5（优化碰
撞能量）将显示错误。(ONYX-8568)

不适用（SCIEX 7500 系统）如果多个离子对有
相同的保留和驻留时间，则只有最后一个
离子对显示在 (s)MRM Plots 对话框的
Dwell Time 图形的工具提示中。
(ONYX-8621)

如果使用一个版本的 SCIEX OS 采集数据，然后将
数据附加到使用另一个版本的 SCIEX OS 的数据文
件，则 wiff 数据文件中记录并显示在 Analyst®

软件的 Sample Information 中的软件版本不正确。
较早的软件版本显示在 File Info 部分中。

如果使用不同版本的 SCIEX OS 采集数
据，则 wiff 数据文件的 Sample
Information 中显示的软件版本信息不正
确。(ONYX-9522)

不适用（ZenoTOFTM 7600 系统）对于使用
Scheduled MRMHR 算法采集的 wiff 文
件，在 PeakView® 软件中样本的 Sample
Information 内显示的周期数量和周期时
间不正确。(ONYX-10623)

关闭 SCIEX OS，然后再次打开它。选择列表中包含
当前项目的处理方法和结果文件。

如果在 Batch 工作区打开了在 SCIEX OS
1.6 或更早版本中创建的批次，则
Processing Method 和 Results File 列
的选择列表为空。(ONYX-11275)
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注释问题

Analyst® TF 软件和 SCIEX OS 以不同的方式记录
校准参数。wiff 文件采用 Analyst® TF 软件模型。

（ZenoTOFTM 7600 系统）wiff 文件中显
示的样本 TOF 质量校准参数与 wiff2 文
件中显示的参数不符。(ONYX-11356)

1. 保存并关闭方法。

2. 打开方法。

3. 在 Advanced 选项卡上清除 Experiment
scheduling。
循环实验显示为“未计划”。

（SCIEX X500 QTOF 和 ZenoTOFTM 7600
系统）使用复杂扫描、IDA、SWATH、MRMHR
创建循环实验时，即使用户未指定实验日
程，循环实验仍显示为计划实验。
(ONYX-11359)

保存并重新打开方法时非整数值被替换为“0”，但
是仍将正确地采集数据，并考虑该非整数值。

（SCIEX X500 QTOF 和 ZenoTOFTM 7600
系统）用户可以在 Exclude former
candidate ions 的 For 字段中输入非整
数值。(ONYX-11383)

在下列条件下，将数据附加到网络资源上的 wiff
文件失败：

• wiff 文件包含 Analyst 软件数据。

• wiff 文件包含损坏数据。

• wiff 文件为只读文件。

• 用户没有 wiff 文件的写入访问权限。

• wiff 文件的大小超过了 2 GB。

SCIEX OS 可能无法将数据附加到网络资
源上的 wiff 文件。(ONYX-11437)

数据、TOF MS TIC 的图形、单个 TOF MSMS TIC 的
图形、TOF MS 谱图和单个 TOF MSMS 谱图在
Explorer 工作区中和 PeakView® 软件中都相同。

Explorer 工作区中的 IDA 总和 TOF MSMS
TIC 的图形 (wiff2) 与 PeakView® 软件
中的图形 (wiff1) 不同。(ONYX-11599)

如果发生此问题，采取如下措施之一：
• 关闭软件，然后再次打开。

• 打开保存的批次，然后使用 Plate Layout 对话
框更新该批次中的 Well Positions。

（Echo® MS 系统）当用户使用 Plate
Layout 对话框填充 Batch 工作区中的
Well Positions 时，有时不会填充 Well
Positions。此问题可能会在以下条件下
发生：

• 当用户在打开 SCIEX OS 后第一次打
开 Batch 工作区时。

• 当用户尝试在空批次中填充 Well
Positions 时。

(ONYX-12525)

为了提高性能，删除 Batch 工作区表格中的孔。选
择表格中的孔，然后单击右键，并选择 Cut。

（Echo® MS 系统）当用户单击 Plate
Layout 对话框上的 Remove All 时，软
件响应得很慢。(ONYX-12726)
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注释问题

确保批次中包含有效的处理方法。（Echo® MS 系统）如果第三方控制软件
在没有有效处理方法的情况下提交采集批
次，则处理会失败。(OPP-287)

开始采集之前，确保流动相瓶中含有足够的流动相，
以完成计划的采集。

（Echo® MS 系统）在采集期间触发流动
相低警告时，采集失败。(OPP-288)

选择目标行中不同的列，并重试。（Echo® MS 系统）当用户使用 Plate
Layout 对话框向 Batch 工作区中的表格
添加样本孔时，所选的孔无法添加。
(OPP-365)

这只是用户界面问题。系统功能不受影响（Echo® MS 系统）未为 AE 样本更新
Queue 工作区中的 Est. Start Time。
(OPP-421)

Analytics 工作区问题

注释问题

当项目根目录被用作 Analyst® 软件的根目录时，
会发生此错误。Analyst® 软件会在根目录中的
Default/Project Information 文件夹中创建一个
或多个以下文件：
• ProjectSettings.atd

• Default Audit Map.cam

• Project.atd

如果 Project Information 文件夹中已存在这些文
件，则删除它们。

项目根目录中的任何 Results Tables
都不会打开。

为避免出现问题，请使用支持的模板之一。请参阅
默认模板。

使用包含图片元素和查询的自定义模板
创建 csv 报告之后，无法从 Results
Table 中创建报告。(BLT-1507)

对于非针对性工作流，请限制为一次处理 20 个样
本。

当使用非针对性工作流时，SCIEX OS 在
处理期间停止响应。(BLT-2069)

在 Analyst® 软件中以 Explore 模式打开数据。对于 Analyst® 软件数据，Q3 分辨率被
报告为 LIT 扫描的最大值。(DS-2220)

目前，仅通用设置对 Library Search 可用。特定化合物的接受度标准不可用。
(LBV-136)

只有当报告不包含任何图形时才支持 csv 报告。csv 报告不支持图形或徽标。(MQ-1361)
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注释问题

回归设置字段并非独立于所选算法。如果用户更改
了一个算法中的回归设置字段，则其他算法中的对
应字段也会发生更改。为避免发生任何问题，在切
换算法时，用户必须根据算法的需要更新回归设置。

更改项目默认页面中某个算法的回归设
置会更新其他算法的回归设置。
(MQ-1376)

如欲避免出现此问题，请先为谱库分配名称，然后
再将其导入。

导入没有名称的谱库时出错。(MQ-1379)

用户可为组中的每个成分手动更改 Expected RT。组中单个成分的预计保留时间可以更改
（Update Retention Time 功能设置为
Group），这会导致预计保留时间和组中
保留时间窗口出现不一致的现象。
(MQ-1511)

除了谱库搜索和化学式发现器分数外，软件还会使
用质量误差、同位素和保留时间分数计算综合分数。
如欲避免包含这些分数，请将每个分数的加权设为
零。

当谱库和搜索化学式发现器的分数为零
或不可用时，则综合分数不为零。
(MQ-1545)

如欲避免出现任何问题，请根据更新的谱图数据库
手动重新处理结果。

添加谱图或将其从数据库中删除时，已
保存的 Results Table 不会自动更新。
(MQ-1684)

如果出现此问题，请确认保留时间、峰质量和积分，
以确定化合物是真阳性。

谱图质量较差，但谱库搜索报告高于预
期的纯度分数。(MQ-1679)

使用 LibraryView Package Builder 1.0 所创建的
许可包的许可证应手动复制到 C:\Program
Files\SCIEX\LibraryView\LibraryViewFramework\Server。

使用 LibraryView Package Builder 所
创建的许可包的许可证保存到
C:\Program Files\AB
SCIEX\LibraryView\bin。(MQ-1847)

创建报告可能需要一段时间。始终在后台显示的
PDFactory 进度窗口显示，正在创建 PDF。用户可
以最小化全部窗口（包括 SCIEX OS），以便查看
PDFactory 进度窗口。

当 PDFactory 从采用阳性匹配模板的包
含超过 2,500 行的 Results Table 中
创建受保护的 PDF 报告时，软件似乎失
去响应。(MQ-1896)

为避免发生问题，手动选择 IS 名称或者单独粘贴
IS 列。

在方法编辑器中，IS 名称不能粘贴到
Components Table 中。(MQ-2193)

为避免发生任何问题，用户必须打开在先前版本的
SCIEX OS 中创建的方法，并更正任何错误。如果错
误未纠正，则处理时间可能会受到影响。

用户可以处理数据，并使用无效的方法
创建 Results Table。(MQ-2431)

请勿对峰形欠佳的 UV/DAD/ADC 数据使用 AutoPeak
积分算法。

当对 UV、DAD 或 ADC 数据使用
AutoPeak 积分算法时，耗费了很长的时
间来建立模型，然后才进行了处理。
(MQ-4421)
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注释问题

将值输入表格。当用户试图按照标记规则中的成分类型
表将值复制进 Concentration
Acceptance 或 Values 的 Upper Limit
列时发生错误。(MQ-5599)

要计算 S/N，在 Explorer 工作区中打开平均 m/z
光谱，进行手动重建，然后计算目标峰的 S/N。

注释： 这种解决方法需要 Biotool Kit 许可。

1. 在 Peak Review 窗格中选择 Average 谱图。

2. 单击 Open data exploration( )。

3. 单击 Bio Tool Kit > Reconstruct Protein，
输入分辨率值，指定重建参数，然后执行重建。

4. 手动计算 S/N。请参阅《软件用户指南》中的
“显示图形选择信息”。

在质量重建工作流中，Results Table
中报告的信噪比 (S/N) 值未被正确计算
用于重建峰。(MQ-7073)

对于标称质量系统，如 SCIEX 7500 系统，不支持
XIC 宽度 (ppm)。使用 XIC 宽度 (Da)。

当用户在处理方法的 Components 页面
配置表格设置以显示 Mass (Da) and
Width (ppm) 时出现错误。(MQ-7709)

指定与函数名称不同的名称。计算列的名称不能与函数名称相同。
(MQ-8087)

GETSTAT 函数使用 Actual Concentration 值识别
重复，但 Statistics 窗格使用的是应用了用户指
定的 Number format 之后的 Actual Concentration
值。例如，如果 Number format 设置为 0.00，则
浓度 5.001 在 Statistics 窗格中将被处理为
5.00。

Statistics 窗格中显示的 Percent CV
与使用 GETSTAT 函数计算出的 CV 百分
比值不同。(MQ-8211)

切勿创建使用 Outlier Reasons 列的标记规则。软件不支持基于 Outlier Reasons 列或
从 Outlier Reasons 列计算出的列的标
记规则。(MQ-8295/MQ-8381)

要刷新度量图表，在 Results Table 中选择不同的
成分，然后再次选择原始成分。

当根据自定义公式将度量图表应用于列
时，对公式的任何输入的更改都不会立
即反应在 Metric Plot 中。(MQ-8524)

切勿在公式中使用 Acquisition Date & Time 列。Acquisition Date & Time 列在公式中
未得到正确处理。(MQ-8662)

要代表布尔 AND（与），使用“&&”。要代表布尔
OR（或），使用“||”。

公式编辑器不会识别在公式中错误使用
& 和 | 字符的情况。(MQ-8837)

确保审核布尔运算符后面的所有语句。公式编辑器不会识别布尔运算符后面的
语法错误。(MQ-8839)
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注释问题

在样本名称中包含孔位置。按名称和孔位置查看样本时，速度很慢。
(ONYX-7457)

不适用ChemSpider 数据库无法通过代理服务器
访问。(PV-632)

Explorer 工作区问题

注释问题

如果发生此问题，等待软件完成 Explorer 工作区
中的处理，或者避免在数据采集期间处理大量数据。

用户在 Explorer 工作区中处理大量数
据或多个数据文件时，用户界面可能会
停止响应，在样本队列移至下一样本时
可能发生延迟。(BLT-719)

如果所选离子的结构未如 Formula Finder 所预测
的包括在 Formula Finder Settings 对话框的
Elemental Composition 选项卡的正离子列表中，
则会发生此错误。例如，对于 m/z 1004 处的离子，
Formula Finder 匹配到 (M+NH4)+。如果此离子未
包括在要搜索的正离子列表中，则会在未找到匹配
时发生错误。

在 Formula Finder 中显示 "The
requested action could not be
completed.Make sure your data is
complete and all fields contain
appropriate values" 错误。(BLT-1423)

如欲避免该问题，请按以下步骤操作：

• 通过单击 File > Show XIC 为所需的实验生成
XIC。

• 生成 XIC/BPC 采集后数据。

• 关闭并重新打开 XIC 窗格。

用户在采集过程中浏览数据时，可能会
发生以下问题：
• 如果未在预定时间前生成预定扫描的
XIC 和 BPC，则实时数据将与采集后
数据不匹配。(DS-903)

• 如果用户使用 Explorer 工作区中的
Move to next 或 Move to previous
在 MS 实验之间进行切换以显示实时
生成的提取离子色谱图 (XIC) 或基峰
色谱图 (BPC)，则 XIC/BPC 窗格中只
显示一个点。

如果开始出现此问题，则等待完成采集再浏览数据。在 LC 方法持续时间超过 MS 方法时，
MS 与 DAD Data Acquisition 面板和
Explorer 工作区中发生实时图形不匹
配。在这种情况下，MS 和 DAD Data
Acquisition 面板在 MS 方法持续时间
结束时都会停止更新，即便 UV、DAD 或
ADC 通道在 Explorer 工作区中仍将实
时更新，直至 LC 方法采集时间结束。
(DS-852)
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注释问题

Z 轴（检测器电压）标记不正确。为避免出现问题，
请使用 Detector Optimization Report 或 Data
Acquisition 面板检查检测器优化期间采集的数据。

Explorer 工作区中未正确显示检测器优
化数据。(DS-1044)

显示的值正确，因为它代表的是峰的质心值。单击
Fill Peaks 打开更好的峰视图。峰标签均被置于相
关峰的最高点（无论其位置如何）。因此，标签看
上去似乎位于错误位置，但值是正确的。

如果出现此问题，则等待完成采集再浏览数据。

XIC 描线中的数字标记误导了 Explorer
工作区。(PV-1009)

用户执行以下操作时，显示一则错误消息：
1. 在 Explorer 工作区中的单独窗格中打开两个文
件，随后为各文件生成一个 XIC 图形。

2. 将 XIC 图形合并到一个窗格内。

3. 在 XIC 窗格内，突出显示一个区域，随后双击
生成质谱。

4. 在所打开的 Process All Overlays? 对话框中，
单击 All Overlaid，随后单击 OK。
此时显示错误消息“Incorrect Argument -
invalid cycle range”，而非质谱。

为避免出现任何问题，选择图形叠加的较窄区域。

用户无法通过 XIC 中突出显示的区域生
成质谱。(PV-1104)

此问题不影响工作流程。当用户打开 Scheduled MRMTM 数据文件、
选择并加载样本，然后单击 Show Sample
Information 时，未显示 IDA 实验的样
本信息。(PV-1330)

MS Tune 工作区问题

注释问题

在手动调谐过程中，最佳参数值不会保存。如欲避
免出现任何问题，在处于手动调谐模式时完成所有
调谐步骤。

（SCIEX X500 QTOF 系统）当用户单击
Save Settings 后在手动调谐过程中，
最佳参数值未保存至仪器定义文件。
(ACQ-2519)

如欲避免出现此问题，请设置开始和停止质量，以
涵括 Q1 中心质量范围。

（SCIEX X500 QTOF 和 ZenoTOFTM 7600
系统）选择 Q1 中心质量时，实时谱图
的质量范围不会正确更新。(DS-915)

再次执行调谐程序。（ZenoTOFTM 7600 系统）如果在 MS Tune
工作区中完成校准后大约五分钟内质谱
仪关闭，则校准设置丢失，将恢复以前
保存的校准设置。(MSCS-2627)
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Reporter 问题

注释问题

发生该错误的原因是未安装
TemplateContentControlManager。遵照以下步骤：
1. 导航至 C:/Program Files/AB
Sciex/ReporterOfficeAddins/
TemplateContentControlManager。

2. 双击 TemplateContentControlManager.vsto。

3. 如果安装了 TemplateContentControlManager，
则单击Close。否则，单击 Install，然后遵照
屏幕上的说明。

当用户尝试编辑报告模板时，发生
Microsoft Office 文档自定义错误。

不适用当用户创建包含 Results Table 的报告
时，自定义列中的值的最后一位总是为
“0”。(MQ-1885)

再次创建报告。如果从报告模板中删除了 For Each
Sample 标签，则无法再将其添加回来。
(RPT-21)

软件安装和激活问题

注释问题

为验证安装了正确版本的软件，请打开 SCIEX OS
并单击 Configuration > About。

在 Setup Wizard 和 Windows Programs
and Features 控制面板中，软件版本号
错误地显示为 1.6 而非 1.6.10。

请联系 sciex.com/request-support。仅应由管理
员安装或删除软件。

如果使用了错误的用户账户，可能会无
法安装 SCIEX OS。(BLT-340)

如果打开了两个 SCIEX OS 安装向导程序实例，且
用户尝试从第二个实例继续进行安装（无论第一个
实例是否关闭），则安装会失败。如欲避免出现此
问题，仅可打开一个安装向导程序实例，然后继续
进行安装。

如果打开了多个安装向导程序实例，可
能无法安装 SCIEX OS。(BLT-341)

如果启用了 FIPS 选项，则无法安装或使用软件。
该选项可从 Windows Control Panel 中的 Local
Computer Policy > Computer Configuration >
Windows Settings > Security Settings > Local
Policies > Security Options 调用。禁用 System
cryptography: Use FIPS compliant algorithms
for encryption, hashing, and signing。

如果在 Windows 中启用了 Federal
Information Processing Standards
(FIPS) 选项，则 SCIEX OS 安装失败。
(BLT-2193)
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注释问题

如果 SCIEX OS 1.3 安装的备份不可用，那么：
1. 删除 SCIEX OS 2.0。

2. 删除 LibraryViewTM Framework。

3. 重命名 C:\Program Data\SCIEX\ 文件夹。

4. 重命名 C:\Program Files\SCIEX\ 文件夹。

5. 重命名 D:\SCIEX OS Data\ 文件夹。

6. 安装 SCIEX OS 1.3。

SCIEX OS 必须重新配置，并且所有方法、设置、用
户等也必须重新创建。

当软件版本从 2.0 降至 1.3 时，
Batch、Queue 和 User 工作区丢失。
(OFX-489)

如果用户尝试使用 Setup.exe 删除 SCIEX OS 1.3
或更早版本，Windows Programs and Features 中
的 SCIEX OS 条目将被删除。但程序本身未被删除，
仍可打开。要删除 SCIEX OS，请运行 SCIEX OS 文
件夹中的 Setup.exe，随后按照屏幕说明安装软件。
此过程会将 SCIEX OS 的条目重新添加到 Windows
Programs and Features 列表中。使用 Programs
and Features 列表删除 SCIEX OS 1.3 或更早版
本。

用户尝试使用 Setup.exe 删除
时，SCIEX OS 1.3 或更早版本未被删
除。(ONYX-2124)

如果发生此问题，则：
1. 删除 LibraryViewTM 软件（如果已安装）。

2. 删除 LibraryViewTM Framework（如果已安装）。

3. 删除所有 Microsoft SQL Server 2008 组件。

4. 关机，然后重新启动计算机。

5. 安装 SCIEX OS。

如果安装问题仍然存在，则可能需要从 C:\Program
Files\Microsoft SQL
Servier\MSSQL10_50.SQLEXPRESS \MSSQL\DATA
folder 中删除 LibraryView.mdf 和
LibraryView_log.mdf 文件。

注释： 由于谱库存储在 mdf 文件中，如果这些文
件被删除，那么现有谱库也将被删除，并且必须重
新安装。

SCIEX OS 有时也可能会因 SQL 服务器
问题或因 LibraryViewTM Framework 问
题而无法安装。(ONYX-2987)

如果发生此问题，则使用安装包中的
Install/NDP472-KB4054530-x86-x64-AllOS-ENU.exe
进行安装。

在没有 .NET Framework 4.x. 的计算机
上安装 SCIEX OS 时显示错误
(ONYX-8028)
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MS FW Updater 问题

描述问题

若要升级质谱仪固件，请将 FirmwareUpdater 文件
夹复制到 D:\ 盘，然后从该位置运行实用工具。

MS FW Updater 实用工具无法在 DVD 光
盘上运行。(BLT-597)

SCIEX OS 至 Analyst® 软件方法转换器问题

描述问题

如果使用的是较早版本的方法转换器，则会出现此
问题。确保使用 SCIEX OS 2.1.6 安装包中包含的
方法转换器版本。

如果方法包含 EMS 扫描，则无法从
SCIEX OS 转换方法。(ONYX-12112)

默认模板

补充说明模板说明（如 Create Report 对话
框所示）

模板

不适用这份报告针对每个样本显示一个区
域，其中包含文件信息、样本信息、
分析物结果表格以及所有分析物和内
标物的叠加色谱图。Analyte Results
Table 按照其在 Results Table 内
的显示内容打印。所有定性置信度红
绿灯均在表格开头处列出。

所有峰定性

此样本报告模板随附了查询文件
Analyte20percent.Query。

这份报告针对每个分析物显示一个区
域，其中包含文件信息以及每一种空
白样本、标准样本、质控样本和 20%
未知样本的 XIC 表。

分析物 20% 报告

不适用这份结果表格显示批次所有样本中特
定分析物及相关内标物的样本名称、
计算浓度和离群值。

分析物摘要

• Reportable 复选框被清除的标准
物将不会在数据表中报告。统计数
据不会受到 Reportable 状态影
响。

• 此报告将根据 Used 列状态显示回
归方程和图形，如 Analytics 工
作区的 Calibration Curve 窗格
中所示和计算。

这份报告显示分析物的文件信息、统
计表（标准物）和校准曲线，每种分
析物占一页。

校准曲线
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补充说明模板说明（如 Create Report 对话
框所示）

模板

此报告专门用于质量重建工作流。这份报告显示每个样本的 Results
Table 条目。所有在 Results Table
中可见的列均会在报告中显示。报告
还包括各样本和分析物的 XIC 色谱
图、平均质谱图和重建质谱图。

完整定量所有峰
和图形

此报告专门用于质量重建工作流。这份报告显示 Results Table 条目、
校准曲线和各分析物统计数据。
Results Table 包括样本名称、样本
类型、分析物名称、实际浓度、面
积、高度、预计 MW、MW、MW 增量、
计算所得浓度和准确度。

完整定量分析物
摘要和校准曲线

此报告专门用于质量重建工作流。这份报告显示所有样本的 Results
Table 条目。Results Table 包括样
本名称、样本类型、分析物名称、实
际浓度、面积、高度、预计 MW、MW、
MW 增量、计算所得浓度、准确度和
准确度接受度。

完整定量样本摘
要

Reportable 复选框的状态不会影响
报告内容。即使清除该复选框，也会
包含所有数据点。

这份报告针对每个分析物显示一个区
域，其中包含文件信息和分析物峰面
积的度量图表。

度量图表

不适用这份报告针对每个分析物显示一个区
域，其中包含文件信息、样本结果表
和每个样本的 XIC 表 - 每个分析物
（< 8 个样本）通常会打印 2 页。

MQ 分析物报告 1

仅报告未知项。这份报告针对每个分析物显示一个区
域，其中包含文件信息和每个未知样
本的 XIC 表 - 每个分析物（< 8 个
样本）通常会打印 2 页。

MQ 分析物报告 2

仅报告未知项。这份报告针对每个分析物显示一个区
域，其中包含文件信息和未知样本摘
要表。

MQ 分析物报告 3

仅报告未知项。这份报告针对每个未知样本显示一个
区域，其中包含文件信息、样本信息
和报告摘要表。该表显示为 2 列，
以便每页能够显示更多样本。

MQ 分析物报告综
合表

仅报告未知项。这份报告针对每个分析物显示一个区
域，其中包含文件信息、样本结果表
和每个样本的小型色谱图。

含色谱图的 MQ
分析物报告

这份报告仅显示标题信息、徽标和页
码。

不适用MQ 空白模板
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补充说明模板说明（如 Create Report 对话
框所示）

模板

与肽定量数据集一起使用。请参阅
MultiQuantTM 软件的用户指南的第二
个示例，绝对定量示例。

不适用MQ 肽定量

清除 Reportable 复选框的质控品不
会包含在报告中，也不会用于计算。

这份报告显示文件信息、每种分析物
的 QC 摘要表（CV 高于 20% 的数值
会突出显示）以及 QC 详细结果表
（准确度在 80-120% 范围之外的数
值会突出显示）。

带标记的 MQ QC
摘要 1

不适用这份报告针对每个样本显示一个区
域，其中包含文件信息、样本信息、
IS 信息、分析物结果表和包含 IS
和各分析物的 XIC 表 - 每个样本（<
8 个样本）通常会打印 2 页。

MQ 样本报告 1

仅报告未知项。这份报告针对每个分析物显示一个区
域，其中包含文件信息、TIC、样本
详细信息、分析物 XIC 和表格形式
的结果 - 每个样本（< 8 个样本）
通常会打印 2 页。

MQ 样本报告 2

仅报告未知项。这份报告针对每个未知样本显示一个
区域，其中包含文件信息、样本信息
和报告摘要表。

MQ 样本报告 3

仅报告未知项。这份报告针对每个未知样本显示一个
区域，其中包含文件信息、样本信息
和报告摘要表。该表显示为 2 列，
以便每页能够显示更多分析物。

MQ 样本报告综合
表

仅报告未知项。这份报告针对每个样本显示一个区
域，其中包含文件信息、样本信息、
分析物结果表和每个分析物的小型色
谱图。

含色谱图的 MQ
样本报告
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补充说明模板说明（如 Create Report 对话
框所示）

模板

• 相关查询文件为包含
Concentration Threshold.query
的样本报告。

• 成分必须命名为 "Cmpd X #”X
#"，其中 X 是从 A 到 F 的任意
字符，# 是任意数值。
示例：在报告中，名为 "Cmpd A
1" 的成分将显示在标题 Compound
Group A 下；名为 "Cmpd B 1" 的
成分将显示在 Compound Group B
下，以此类推。

• 如果成分属于同一个组，则该组中
仅按字母顺序的第一个成分将被纳
入报告。
例 1：如果 "Cmpd B 25" 和
"Cmpd C 1" 都属于组 "Grp"，则
"Cmpd C 1" 不会出现在报告中。

例 2：如果 "Cmpd A 1"、 "Cmpd
A 2" 和 "Cmpd A 3" 未分配到
组，则 "Cmpd A 2" 和 "Cmpd A
3" 将不会出现在报告中。

例 3：如果 "Cmpd A 1"、"Cmpd
A 2" 和 "Cmpd A 3" 分别分配到
组 1、2 和 3，则所有 3 个成分
都将出现在报告的 Compound
Group A 标题下。

这份报告针对每个未知样本显示一个
区域，其中包含文件信息、样本信息
和报告摘要。

含浓度阈值的 MQ
样本报告

不适用这份报告针对每个未知样本显示一个
区域，其中包含文件信息、样本信
息、报告摘要表和所有 XIC 叠加图。
Expected Ion 率可采用任何可用标
准物自动计算。比值被放在 Results
Table 的自定义列中。任何与预计值
偏差超过 20% 的值都会被标记。定
量离子分析物名称必须以一个空格后
接数字 1 为结尾。比值离子分析物
名称必须以一个空格后接 2 和 9 之
间的某个数字为结尾。

含 MRM 比的 MQ
样本报告 2
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补充说明模板说明（如 Create Report 对话
框所示）

模板

相关查询文件为 MRM ratios
EU.query。

这份报告针对每个未知样本显示一个
区域，其中包含文件信息、样本信息
和报告摘要表。Expected Ion 率可
采用任何可用标准物自动计算。比值
被放在 Results Table 的自定义列
中。任何超过预计值的数值都会被标
记（依据 EU 比值公差指引）定量离
子分析物名称必须以一个空格后接数
字 1 为结尾。比值离子分析物名称
必须以一个空格后接 2 和 9 之间的
某个数字为结尾。

含 MRM 比的 MQ
样本报告 EU

不适用这份报告针对每个未知样本显示一个
区域，其中包含文件信息、样本信息
和报告摘要表。Expected Ion 率可
采用任何可用标准物自动计算。比值
被放在 Results Table 的自定义列
中。任何与预计值偏差超过 20% 的
值都会被标记。定量离子分析物名称
必须以一个空格后接数字 1 为结尾。
比值离子分析物名称必须以一个空格
后接 2 和 9 之间的某个数字为结
尾。

含 MRM 比的 MQ
样本报告 MQ
EFAB 03

相关查询文件为 MRM ratios.query。这份报告针对每个未知样本显示一个
区域，其中包含文件信息、样本信息
和报告摘要表。Expected Ion 率可
采用任何可用标准物自动计算。比值
被放在 Results Table 的自定义列
中。任何与预计值偏差超过 20% 的
值都会被标记。定量离子分析物名称
必须以一个空格后接数字 1 为结尾。
比值离子分析物名称必须以一个空格
后接 2 和 9 之间的某个数字为结
尾。

含 MRM 比的 MQ
样本报告

清除 Reportable 复选框的标准物和
质控品不会包含在报告各自的综合表
中，也不会用于统计计算。

这份报告针对每个样本显示一个区
域，其中包含文件信息、标准物摘要
信息、质控品摘要表、空白品结果
表；并针对每个未知样本显示一个区
域，包含文件信息、样本信息、IS
信息、分析物结果表和包含 IS 和各
分析物的 XIC 表 - 每个样本（< 8
个样本）通常会打印 2 页。

含标准物、质控
品和空白品的 MQ
样本报告
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补充说明模板说明（如 Create Report 对话
框所示）

模板

此报告用于与 Tutorial Dataset
Heavy Light 数据集一起使用。请参
阅 MultiQuantTM软件的用户指南的第
二个示例，相对定量示例。

不适用MQ Tutorial
Dataset Heavy
Light

不适用这份报告针对每个选定样本显示一个
区域，其中包含文件信息、样本信息
和选定分析物的分析物结果表。
Analyte Results Table 按照其在
Results Table 内的显示内容打印。
所有定性置信度红绿灯均在表格开头
处列出。

每个样本定量-定
性

行的隐藏状态优先于 Reportable 复
选框的状态。如选中 Reportable 复
选框，但行已隐藏，则不会报告该
行。

这份报告针对每个选定样本显示一个
区域，其中包含文件信息、样本信息
和选定分析物的分析物结果表。
Analyte Results Table 按照其在
Results Table 内的显示内容打印。
所有定性置信度红绿灯均在表格开头
处列出。

每个样本定量-定
性可见行（使用
可见分析物）

• 如果成分表包含 UV 成分，则 UV
轨迹将在该报告的 XIC 图形下报
告。

注释： 如果 UV 成分的名称采
用格式 [compound_nameuv] 或
[uv]，则不报告任何 UV 轨迹，
因为 uv 后缀与 UV MS 定性报
告相关。

• 如果样本被标记为 QC，且有 2 个
或以上样本，则将计算均值、
STDEV 和 %CV 并将其包含在报告
末尾的 QC 摘要表中。

• 如果清除 QC 行的 Reportable 复
选框，则该行不会用于 QC 摘要表
的任何计算。

这份报告显示每个样本的成分以及
WYSIWYG 表。显示 XIC、MS 和
MS/MS。面积的统计综合表显示在报
告末尾。

每个样本定量-定
性（含统计数
据）

不适用这份报告针对每个分析物显示一个区
域，其中包含文件信息、Results
Table、校准曲线以及内标物和每种
分析物的色谱图。该模板适合已定义
分组的 Results Table。

每个分析物定量-
定性
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补充说明模板说明（如 Create Report 对话
框所示）

模板

不适用这份报告针对每个选定样本显示一个
区域，其中包含文件信息；样本信
息；选定分析物的分析物结果表；所
有分析物、内标物和 XIC 的叠加色
谱图；已采集/理论 MS 质谱；每种
选定分析物的已采集/谱库 MS/MS 质
谱。Analyte Results Table 按照其
在 Results Table 内的显示内容打
印。所有定性置信度红绿灯均在表格
开头处列出。

确定匹配定性

建议对报告格式使用 CSV 选项。这份报告以 .csv 格式针对每个样本
显示一个区域，其中包含文件信息、
样本信息和分析物结果表。

定性 CSV 报告

不适用这份报告针对每个样本显示一个区
域，其中包含分析物摘要表。该报告
模板适合已分组的 Results Table。

样本摘要

• 处理 UVMS 数据时应遵循命名惯
例，使用 compound 1 （任何字符
串）代表质谱仪 (MS) 成分，
compound 1uv（任何字符串 +
uv）代表相应的 UV 成分。

• 仅会显示质量误差、碎片质量误
差、RT 置信度、同位素置信度和
谱库置信度红绿灯。

• 可创建图形表来显示 Results
Table 的各个成分，包括化合物
1 的 XIC、MS1 轨迹、MS/MS 轨迹
和标题信息，以及化合物 1uv 的
UV 轨迹。请参阅图 1。

• 分析物图形仅可重复用于 MS 实
验，而不能用于 UV 实验。

• 如果样本被标记为 QC，且有 2 个
或以上样本，则将计算均值、
STDEV 和 %CV 并将其包含在报告
末尾的 QC 摘要表中。请参阅图
1。

• 如果清除 QC 行的 Reportable 复
选框，则该行不会用于 QC 摘要表
的任何计算。

这份报告通过 WYSIWYG 表针对每个
样本显示该样本的成分及其对应的
UV 成分。报告会显示 XIC、MS 和
MS/MS 以及 UV 数据。面积的统计综
合表显示在报告末尾。

UV MS 定性报告
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图 1 图形表

图 2 统计表

联系我们

客户培训

• 北美地区：NA.CustomerTraining@sciex.com

• 欧洲：Europe.CustomerTraining@sciex.com

• 在欧盟与北美之外请访问 sciex.com/education

在线学习中心

• SCIEX University™

33 / 352021 年 6 月RUO-IDV-03-1821-ZH-S

SCIEX OS 2.1.6 版本发布说明

mailto:NA.CustomerTraining@sciex.com
mailto:Europe.CustomerTraining@sciex.com
https://sciex.com/education
https://training.sciex.com


SCIEX 支持

SCIEX 及其代表在全球范围内设有经过系统培训的服务和技术专家。他们可以解答系统问题或
可能出现的任何技术问题。详情请访问 SCIEX 网站 sciex.com 或通过下述方式之一联系我们：

• sciex.com/contact-us

• sciex.com/request-support

网络安全

有关 SCIEX 产品的最新网络安全指南，请访问 sciex.com/productsecurity。

文档

本版本的文档取代本文档的所有先前版本。

要查看本文档的电子版本，需要 Adobe Acrobat Reader。要下载最新版本，请转到
https://get.adobe.com/reader。

要查找软件产品文档，请参阅软件随附的版本发布说明或软件安装指南。

要查找硬件产品文档，请参阅系统或组件随附的客户参考 DVD。

最新版本的文档可从 SCIEX 网站上获得，网址：sciex.com/customer-documents。

注释： 如需免费获取本文档的印刷版本，请联系 sciex.com/contact-us。
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本文件供已购买 SCIEX 设备的客户在操作此 SCIEX 设备时使用。本文件受版权保护，除非 SCIEX 书面
授权，否则严禁对本文件或本文件任何部分进行任何形式的复制。

本文中所介绍的软件依据许可协议提供。除许可证协议中特别准许的情况外，在任何媒介上复制、修改
或传播本软件均为违法行为。此外，许可协议禁止出于任何目的对本软件进行分解、逆向工程或反编译。
质保条款见文中所述。

本文件的部分内容可能涉及到其他制造商和/或其产品，其中可能有一些部件的名称属于各自所有者的注
册商标和/或起到商标的作用。这些内容的使用仅仅是为了表明这些制造商的产品由 SCIEX 提供以用于
整合到 SCIEX 的设备中，并不意味 SCIEX 有权和/或许可来使用或允许他人使用这些制造商的产品和/
或允许他人将制造商产品名称作为商标来进行使用。

SCIEX 的质量保证仅限于在销售或为其产品发放许可证时所提供的明确保证，而且是 SCIEX 的唯一且独
有的表述、保证和义务。SCIEX 不作任何其他形式的明确或隐含的质量保证，包括但不限于特定目的的
适销性或适用性的保证，不论是法规或法律所规定、还是源于由贸易洽谈或商业惯例，对所有这些要求
均明确免责，概不承担任何责任或相关后果，包括由于购买者的使用或由此引起的任何不良情况所造成
的间接或从属损害。

仅供研究使用。请勿用于诊断过程。

本文提及的商标和/或注册商标，包括相关标志，是 AB Sciex Pte. Ltd. 或各自所有者在美国和/或某
些其他国家的财产(参见 sciex.com/trademarks)。

AB SCIEX™ 的使用经过许可。

© 2021 年 DH Tech. Dev. Pte. Ltd.

爱博才思有限公司 AB Sciex Pte. Ltd.
Blk33, #04-06 Marsiling Industrial Estate Road 3
Woodlands Central Industrial Estate, Singapore 739256

35 / 352021 年 6 月RUO-IDV-03-1821-ZH-S

SCIEX OS 2.1.6 版本发布说明


	介绍
	版本 2.1.6 的新增功能
	2.1.6 版的新功能和改进
	已在 2.1.6 版中解决的问题

	使用注意事项和已知问题
	使用注意事项
	一般问题
	设备问题
	采集问题
	Analytics 工作区问题
	Explorer 工作区问题
	MS Tune 工作区问题
	Reporter 问题
	软件安装和激活问题
	MS FW Updater 问题
	SCIEX OS 至 Analyst 软件方法转换器问题

	默认模板
	联系我们
	客户培训
	在线学习中心
	SCIEX 支持
	网络安全
	文档


